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M. Zumstein & F. Maag
Grundkompetenzen I
Tastaturlayouts & Fonts

Slavisiere deinen Computer
Windows

1 Tastaturlayouts hinzufügen
Die nachfolgende Anleitung geht von Windows 7 aus, in vielen Punkten sollte das Vorgehen unter
Windows 8 ähnlich sein. Bei Abweichungen vgl. den Abschnitt “Hinzufügen eines Tastaturlayouts
oder einer Eingabemethode für eine Sprache” in dieser Anleitung für Windows 8.

• Schritt 1: Rufe das Fenster “Systemsteuerung” auf, indem du wie auf Abbildung 1 gezeigt
im Startmenü auf Systemsteuerung klickst

Abbildung 1: Systemsteuerung anwählen

• Schritt 2: Gehe nun wie auf Abbildung 2 gezeigt vor, um das Fenster “Textdienste und
Eingabesprachen” aufzurufen:

1. Wähle im Systemsteuerungsfenster die Option Tastaturen und Eingabemetho-
den ändern
⇒ Es erscheint ein neues Fenster “Region und Sprache”

2. Wähle dort den Reiter Tastaturen und Sprachen an und
3. Drücke dann auf den Knopf Tastaturen ändern...

⇒ Es erscheint ein neues Fenster “Textdienste und Eingabesprachen” (vgl. das linke
Fenster auf Abbildung 3)
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Abbildung 2: Tastaturen und Eingabemethoden ändern

• Schritt 3: Lass dir die bereits installierten Tastaturlayouts anzeigen und öffne das Fens-
ter, in welchem du weitere Eingabesprachen und Tastaturlayouts hinzufügen kannst (vgl.
Abbildung 3):

1. Klicke im Fenster “Textdienste und Eingabesprachen” auf den Reiter Allgemein
∗ Hier werden alle Sprachen aufgelistet, deren Tastaturlayout installiert ist1

2. Drücke den Knopf Hinzufügen, so dass das Fenster “Eingabesprache hinzufügen”
erscheint

Abbildung 3: Bereits installierte Tastaturlayouts und Installation weiterer Tastaturlayouts

• Schritt 4: Suche im Fenster “Eingabesprache hinzufügen” eine Sprache, deren Tastatur-
layout du künftig zur Verfügung haben möchtest.2 Gehe nach Abbildung 4 vor:

1Auf Abbildung 3 ist dies DE Deutsch (Schweiz).
2In Abbildung 4 sind dies “Polnisch (214)” und “Russisch”.
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1. Klicke auf das + vor dem Sprachnamen
2. auf das + vor “Tastatur”
3. und aktiviere dann das Kontrollkästchen vor dem Tastaturlayout

∗ Wiederhole diesen Schritt für so viele Sprachen wie du möchtest
4. Klicke am Schluss auf OK, das Fenster “Eingabgesprache hinzufügen” schliesst sich

Abbildung 4: Auswahl hinzuzufügender Tastaturlayouts

⇒ Die gewählte Sprache erscheint nun neu im Fenster “Textdienste und Eingabesprachen”
im Feld “Installierte Dienste”.
Vgl. Abbildung 5, auf der unter den “Installierten Diensten” nun neben Deutsch neu auch
Polnisch und Russisch aufgelistet sind

• Schritt 5: Bestätige die soeben vorgenommenen Änderungen wie auf Abbildung 5 gezeigt:
1. Klicke im Fenster “Textdienste und Eingabesprachen” auf Übernehmen
2. Klicke im Fenster “Textdienste und Eingabesprachen” auf Ok

Abbildung 5: Bestätigen der hinzuzufügenden Tastaturlayouts

⇒ Nun sind die gewünschten zusätzlichen Tastaturlayouts installiert
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• D.h. dass auf dem Computer nun verschiedene Tastaturlayouts verwendet werden können,
in unserem Beispiel sind dies Deutsch, Polnisch und Russisch.

→ In Abschnitt 2 wird gezeigt, wo man sehen kann, welches Tastaturlayout gerade ak-
tuell benutzt wird

→ In Abschnitt 3 wird erklärt, wie man von einem Tastaturlayout zu einem anderen
wechseln kann, sprich wie man die verschiedenen Tastaturbelegungen, die man soeben
installiert hat, auch nutzen kann

2 Sprachenleiste
• Auf der Sprachenleiste wird angezeigt, welches Tastaturlayout man gerade zur Eingabe

verwendet. Die Sprachenleiste befindet sich i.d.R. in der rechten unteren Ecke des Bild-
schirmes.
Vgl. Abbildung 6, auf der man die Sprache DE in der Sprachenleiste angezeigt sieht.

Abbildung 6: Sprachenleiste

• Falls die Sprachenleiste nicht angezeigt wird, muss man sie zuerst sichtbar machen

• Die nachfolgende Anleitung geht von Windows 7 aus, in vielen Punkten sollte das Vorgehen
unter Windows 8 ähnlich sein. Bei Abweichungen vgl. diese Anleitung zum Vorgehen auf
Windows 8.

• Schritt 1: Rufe das Fenster “Textdienste und Eingabesprachen” auf – dies wird als Schritt
1 und 2 in Abschnitt 1 beschrieben

• Schritt 2: Gehe danach wie auf Abbildung 7 gezeigt vor:
2. Klicke im neu erschienen Fenster “Textdienste und Eingabesprachen” auf den Reiter

Sprachenleiste
3. Wähle die Option Auf Taskleiste fixieren an
4. Aktiviere sowohl die Option Weitere Sprachenleistensymbole in der Taskleiste

anzeigen als auch Sprachenleiste mit Texttiteln anzeigen
5. Bestätige die soeben vorgenommenen Änderungen indem du auf OK im Fenster

“Textdienste und Eingabesprachen” drückst
6. Bringe die Änderungen zur Anwendung, indem du im Fenster “Region und Sprache”

von vorhin auf den Knopf Übernehmen drückst
7. Schliesse zu guter Letzt das Fenster “Region und Sprache” indem du OK drückst
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Abbildung 7: Tastaturen und Eingabemethoden ändern

3 Zwischen Tastaturbelegungen wechseln
Es gibt zwei Möglichkeiten, wie man zwischen den verschiedenen installierten Tastaturbelegun-
gen wechseln kann:

1. Indem man auf die Sprachenleiste klickt und dort die betreffende Eingabesprache auswählt
⇒ Vgl. Abschnitt 3.1

2. Indem man mit Tastenkombinationen (auch “Shortcuts” genannt) arbeitet, die einem das
Klicken ersparen
⇒ Vgl. Abschnitt 3.2

Die nachfolgende Anleitung geht von Windows 7 aus, in vielen Punkten sollte das Vorge-
hen unter Windows 8 ähnlich sein. Bei Abweichungen vgl. den Abschnitt “Wechseln zwischen
Tastaturlayouts oder Eingabemethoden” in dieser Anleitung für Windows 8.

3.1 Durch Klicken in der Sprachenleiste
• Klicke wie auf Abbildung 8 gezeigt auf die Sprachenleiste unten rechts, um alle installierten

Eingabesprachen anzuzeigen und gezielt eine von ihnen anzuwählen

• In Abbildung 8 sind dies “DE Deutsch (Schweiz)”, “PL Polnisch (Polen)” sowie “RU
Russisch (Russische Föderation)”

Abbildung 8: Wahl des Tastaturlayouts in der Sprachenleiste
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3.2 Durch die Verwendung von Tastenkombinationen
• Die Verwendung von Tastenkombinationen (auch “Shortcut” genannt) erspart einem das

Klicken mit der Maus und führt aber die gleiche Aktion aus

• CTRL + C beispielsweise ist die Tastenkombination für die Aktion “kopieren” und leistet
also dasselbe wie ein Rechtsklick mit der Maus und anschliessende Auswahl der Aktion
“Kopieren” im erschienen Menü

• Man kann sowohl eine Tastenkombination für den Wechsel zwischen den verschiedenen
Eingabesprachen festlegen (vgl. Abschnitt 3.2.1) als auch jeder installierten Sprache eine
spezifische Tastenkombination zuweisen (vgl. Abschnitt 3.2.2), so dass sie direkt angewählt
wird
⇒ Dies erspart einem das Klicken auf die Sprachenleiste, lässt einen also schneller ar-

beiten

3.2.1 Tastenkombination zum Wechsel zwischen Tastaturbelegungen

• Schritt 1: Rufe das Fenster “Textdienste und Eingabesprachen” auf – dies wird als Schritt
1 und 2 in Abschnitt 1 beschrieben

• Schritt 2: Rufe wie auf Abbildung 9 gezeigt das Fenster “Tastenkombination ändern” auf:
1. Wähle im Fenster “Textdienste und Eingabesprachen” den Reiter Erweiterte Tas-

tatureinstellungen an
2. Wähle Zwischen Eingabesprachen an
3. Drücke auf den Knopf Tastenkombination ändern...

⇒ Es erscheint das Fenster “Tastenkombination ändern”

Abbildung 9: Das Fenster zur Änderung der Tastenkombination aufrufen
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• Schritt 3: Lege nun wie auf Abbildung 10 gezeigt die Tastenkombinationen fest:
1. Wähle unter “Eingabesprache wechseln” aus, mit welcher Tastenkombination du zwi-

schen den verschiedenen Eingabesprachen3 wechseln können willst
2. Wähle unter “Tastaturlayout wechseln” aus, mit welcher Tastenkombination du zwi-

schen den verschiedenen Tastaturlayouts4 wechseln können willst
3. Bestätige deine Auswahl durch das Drücken des OK-Knopfes im aktuellen Fenster

“Tastenkombinationen ändern”
⇒ Das Fenster “Tastenkombinationen ändern” schliesst sich

Abbildung 10: Tastenkombination festlegen

• Schritt 4: Bestätige die vorgenommen Änderungen wie auf Abbildung 11 gezeigt:
1. Bringe die vorgenommen Änderungen durch das Drücken von Übernehmen im Fens-

ter “Textdienste und Eingabesprachen” zur Anwendung
2. Klicke zur letzten Bestätigung im gleichen Fenster auf OK

Abbildung 11: Vorher festgelegte Tastenkombination bestätigen

3Auf Abbildung 4 sind das die im 1. Schritt angewählten Sprachen, z.B. Polnisch (Polen) bzw. Russisch (Russische
Föderation); in der Sprachenleiste erscheinen sie mit einer Buchstabenabkürzung, z.B. PL für Polnisch.

4Auf Abbildung 4 sind das die im 3. Schritt angewählten Tastaturbelegungen, da es für ein und dieselbe Sprache
mehrere verfügbare Tastaturlayouts geben kann, in Abbildung 4 sind das für die Sprache Polnisch beispielswei-
se die Tastaturlayouts “Englisch (USA, International)”, “Polnisch (214)” sowie “Polnisch (Programmierer)”,
wobei man sich noch weitere anzeigen lassen könnte.
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⇒ Nun kann mit der vorhin festgelegten Tastaturkombination5 zwischen den einzelnen Ein-
gabesprachen gewechselt werden. Des Weiteren kann auch zwischen den verschiedenen
Tastaturlayouts, die ev. innerhalb einer Sprache zur Verfügung stehen, mit einer Tasten-
kombination gewechselt werden.6

3.2.2 Tastenkombination zur Direktwahl einer spezifischen Sprache

• Man kann Tastenkombinationen festlegen, die eine bestimmte Tastaturbelegung direkt
anwählen. Dies ist von Vorteil, wenn man mehrere Eingabesprachen und Tastaturlayouts
installiert hat, weil man sich dann nicht durch alle Optionen “durchzuklicken” braucht.

• Auf Abbildung 11 beispielsweise ist der Eingabesprache “Deutsch (Schweiz)” mit dem
Tastaturlayout “Deutsch (Schweiz)” die Tastenkombination Linke Alt + Umschalt + 1
zugewiesen, d.h. sie kann direkt angewählt werden.
Der Eingabesprache “Polnisch (Polen)” mit dem Tastaturlayout “Polnisch (214)” dagegen
ist noch keine Tastenkombination zugewiesen, genauso wenig wie auch der Eingabesprache
“Russisch (Russische Föderation)” mit dem Tastaturlayout “Russisch”.

⇒ Im Nachfolgenden wird nun gezeigt, wie man nun Tastenkombinationen für die ein-
zelnen Eingabesprachen festlegen kann.

• Schritt 1: Rufe das Fenster “Textdienste und Eingabesprachen” auf – dies wird als Schritt
1 und 2 in Abschnitt 1 beschrieben

• Schritt 2: Rufe wie auf Abbildung 12 gezeigt das Fenster “Tastenkombination ändern” für
die betreffende Sprache auf:

1. Wähle die Sprache aus, der du eine Tastenkombination zuweisen möchtest, in unserem
Beispiel: Polnisch

2. Drücke auf den Knopf Tastenkombination ändern...
⇒ Das Fenster “Tastenkombination ändern” erscheint

Abbildung 12: Das Fenster zur Änderung der Tastenkombination aufrufen
5In unserem Beispiel: Linke Alt + Umschalt, wie auf Abbildung 10 festgelegt bzw. auf Abbildung 11 angezeigt
6In unserem Beispiel: Strg + Umschalt.
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• Schritt 3: Lege nun wie auf Abbildung 13 gezeigt die Tastenkombinationen für die gewählte
Eingabesprache (hier: Polnisch) fest:

1. Aktiviere das Kontrollkästchen Tastenkombination aktivieren
2. Lege den ersten Teil der Tastenkombination fest (auf Abbildung 13 stehen Strg, Strc

+ Umschalt sowie Linke Alt + Umschalt zur Verfügung)
3. Lege den zweiten Teil der Tastenkombination fest (den sog. “Schlüssel”)
4. Bestätige deine Auswahl durch das Drücken des OK-Knopfes im aktuellen Fenster

“Tastenkombinationen ändern”
⇒ Das Fenster “Tastenkombinationen ändern” schliesst sich

Abbildung 13: Festlegen einer Tastenkombination für eine konkrete Eingabesprache und ihr Tas-
taturlayout

• Im Fenster “Textdienste und Eingabesprachen” sollte nun die vorhin ausgesuchte Tasten-
kombination bei der entsprechenden Sprache eingetragen sein, vgl. Abbildung 14, auf der
nun neu neben “Polnisch (Polen) – Polnisch 214” die Tastenkombination “Linke Alt +
Umschalt + 2” eingetragen ist (siehe zum Vergleich Abbildung 12, wo Polnisch noch keine
Tastenkombination zugewiesen war).

Abbildung 14: Neueingetragene Tastenkombination

• Schritt 4: Bestätige die vorgenommen Änderungen – dies wird als Schritt 4 in Abschnitt
3.2.1 beschrieben
⇒ Nun kann mit der soeben festgelegten Tastenkombination (Linke Alt + Umschalt +

2) die Eingabesprache Polnisch und ihr Tastaturlayout direkt angewählt werden

© M. Zumstein & F. Maag 9 19. Februar 2016
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4 Fonts / Schriftarten
• Keine Schriftart kann alle Zeichen darstellen, die es in Unicode gibt

⇒ Daher muss man immer sicherstellen, dass man eine Schriftart wählt, die
alle Zeichen, die man verwendet, darstellen kann. Wenn dies nicht der Fall
ist, werden die “unbekannten” Zeichen in Abhängigkeit vom benutzten Programm
entweder als Kästchen, Fragezeichen oder gar nicht dargestellt.

• Link zu einer Liste mit allen Unicode-Fonts auf Wikipedia

Abbildung 15: Eine Auswahl von Schriftarten, die Altkirchenslavisch wiedergeben können

Zusätzliche Schriftarten installieren:

• Gewünschte Schriftart herunterladen (z.B. BukyVede für Altkirchenslavisch)
– Falls es verschiedene Versionen ein und desselben Fonts gibt (upright, italic, bold),

so sollen alle runtergeladen werden

1. Installationsdialog durch Doppelklick auf die heruntergeladene Schriftart beginnen (in un-
serem Beispiel: BukyVede-Regular.ttf – TrueType font)

2. Den Installieren-Knopf drücken im Fenster

3. Ggf. den Computer neustarten (falls die neu installierte Schriftart von den Programmen
nicht automatisch geladen und zur Auswahl gestellt wird)

5 Sonderzeichen einfügen
5.1 In Word

• Gehe vor wie auf Abbildung 16 gezeigt:
1. Wähle unter Einfügen > Symbol > Weitere Symbole

⇒ Das Fenster “Symbol” erscheint
2. Wähle ggf. eine andere Schriftart; in Abbildung 16 wurde “CMU Serif” gewählt
3. Wähle das gewünschte Zeichen-Subset aus; in Abbildung 16 ist es “Kyrillisch”
4. Suche in der Zeichenauswahl nach dem gewünschten Zeichen und wähle es mit einem

Doppelklick an, dann wird es ins Dokument an der Cursorposition eingefügt

© M. Zumstein & F. Maag 10 19. Februar 2016
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Abbildung 16: Sonderzeichen auswählen und einfügen in Word

5.2 In OpenOffice
• Gehe vor wie auf Abbildung 17 gezeigt:

1. Wähle unter Einfügen > Sonderzeichen...
⇒ Das Fenster “Sonderzeichen” erscheint

2. Wähle ggf. eine andere Schrift; in Abbildung 17 wurde “Times New Roman” gewählt
3. Wähle den gewünschten Zeichen-Bereich aus; in Abbildung 17 ist es “Kyrillisch”
4. Suche in der Zeichenauswahl nach dem gewünschten Zeichen und wähle es mit einem

Doppelklick an, dann wird es ins Dokument an der Cursorposition eingefügt

Abbildung 17: Sonderzeichen auswählen und einfügen in OpenOffice

5.3 Mit der Zeichentabelle (Character Viewer)
• Die Zeichentabelle wie in Abbildung 18 gezeigt aufrufen:

1. Im Suchfeld des Startmenüs “Zeichen” eingeben

© M. Zumstein & F. Maag 11 19. Februar 2016
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2. Das Suchresultat “Zeichentabelle” in den Programmen auswählen
⇒ Die Zeichentabelle öffnet sich in einem neuen Fenster (vgl. Abbildung 19)

Abbildung 18: Aufrufen der Zeichentabelle

Abbildung 19: Aufrufen der Zeichentabelle

• Wähle ggf. eine andere Schriftart; in Abbildung 19 wurde “CMU Sans Serif” gewählt

• Suche in der Zeichenauswahl nach dem gewünschten Zeichen und wähle es mit einem
Doppelklick an, dann wird es ins Feld “Zeichenauwahl” eingefügt

• Von da kann es kopiert und in dem Programm, in dem es benötigt wird, eingefügt werden

6 Erstellen eines eigenen Tastaturlayouts
Vergleiche auch: Tutorial online

1. The Microsoft Keyboard Layout Creator herunterladen
WICHTIG: Funktioniert sowohl auf Windows 7 als auch auf Windows 8, auch wenn das
beim Download so nicht geschrieben steht

© M. Zumstein & F. Maag 12 19. Februar 2016
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2. Installation des heruntergeladenen Programmes (MSKLC.exe) durch Doppelklick beginnen

3. Das installierte Programm öffnen – es sollte wie auf Abbildung 20 eine leere Tastatur
angezeigt werden7

Abbildung 20: Ausgangslage: leere Tastatur

4. Ggf. unter View > Font... die Schriftart anpassen (vgl. Abbildung 21), und zwar eine
Schriftart wählen, die alle gewünschten Zeichen darstellen kann (z.B. Roman Cyrillic Std)

Abbildung 21: Schriftart für die Zeichendarstellung bei der Tastaturbelegun anpassen

5. Eine existierende Tastaturbelegung als Vorlage laden:
File > Load Existing Keyboard

6. Vorlage nach eigenem Geschmack abändern:
• Hellgraue Tasten können verändert werden: Anklicken und es erscheint ein Fenster,

in welchem man das Zeichen eingeben kann, das man neu an dieser Stelle möchte
• Dunkelgraue Tasten sind tote Tasten, also unveränderlich
• Links kann man durch das Anwählen von “Shift states” weitere Belegungen vergeben

7. Speichere die Tastatur:
• Indem du unter File auf Save Source File klickst
• Merke dir, wie du sie benennst (z.B. slav.klc) und wo du sie speicherst!

7Falls nicht (v.a. bei Windows 8 auf Tabletts die Gefahr): DPI setting anpassen (von default auf 126%)
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• Info: Die Tastatur wird automatisch als Tastaturlayout (und zwar als “Custom”-
Variante) derjenigen Sprache abgespeichert, die man als Grundlage für die Tastatur-
belegung gewählt hat

• Wenn man das ändern möchte (eher nicht empfohlen), so gehe man auf Project >
Properties und nehme im sich öffnenden Fenster “Properties” (vgl. Abbildung 22)
die gewünschten Änderungen vor

Abbildung 22: Properties

8. Öffne die eben gespeicherte Tastatur im Keyboard Layout Creator:
• Variante A: Keyboard Layout Creator erneut öffnen, unter File auf Load Source

File klicken, dann die gespeicherte Tastatur (in unserem Beispiel slav.klc) anwählen
• Variante B: Das gespeicherte File (in unserem Beispiel slav.klc) durch Doppelklick

öffnen

9. Wähle unter Project > Build DLL and Setup Package

10. Danach sollte eine Meldung erscheinen “Verification succeeded” und ein Fenster, in dem
gefragt wird, ob man das Verzeichnis sehen will, in welchem die neuen Files liegen (vgl.
Abbildung 23) – klicke auf Ja

Abbildung 23: Properties

11. Darauf hin wird ein Ordner geöffnet, in dem verschiedene Files liegen (vgl. Abbildung 24)
1. Das File setup.exe anwählen und doppelklicken

© M. Zumstein & F. Maag 14 19. Februar 2016
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⇒ Die neugestaltete Tastaturbelegung wird installiert
2. Das danach aufscheinende Fenster mit der Meldung “Installation Complete” schlies-

sen

Abbildung 24: Installation der neugestalteten Tastaturbelegung

12. Die selber gestaltete Tastaturbelegung zu den anderen anwählbaren Tastaturbelegungen
hinzufügen wie oben (Abschnitt 1) beschrieben; sie erscheint als “Custom”-Variante der
Sprache, deren Tastaturbelegung man als Grundlage genommen hatte (z.B. “Russisch
Custom”)

• Falls du die Tastaturen nicht mehr brauchst. . .
… findest du hier eine Anleitung zur Deinstallation von Keyboards

© M. Zumstein & F. Maag 15 19. Februar 2016

http://superuser.com/questions/170651/how-can-i-uninstall-a-keyboard-that-microsoft-keyboard-layout-creator-created

	Tastaturlayouts hinzufügen
	Sprachenleiste
	Zwischen Tastaturbelegungen wechseln
	Durch Klicken in der Sprachenleiste
	Durch die Verwendung von Tastenkombinationen
	Tastenkombination zum Wechsel zwischen Tastaturbelegungen
	Tastenkombination zur Direktwahl einer spezifischen Sprache


	Fonts / Schriftarten
	Sonderzeichen einfügen
	In Word
	In OpenOffice
	Mit der Zeichentabelle (Character Viewer)

	Erstellen eines eigenen Tastaturlayouts

